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SAP2000 v25.0.0 Release Notes
© 2023 Computers and Structures, Inc.

Notice Date: 07-July-2023

This document lists changes made to SAP2000 since v24.2.0, released 15-February-2023. Items marked
with an asterisk (*) in the first column are more significant.

Analysis
Enhancements Implemented
* Ticket Description

9386 A new option has been added when specifying viscous proportional damping for time-
history and response-spectrum load cases where the mass- and stiffness-proportional
coefficients can be calculated during analysis to provide specific modal damping ratios at
frequencies or periods that are relative to a given mode of the structure. Viscous
proportional damping is always used for direct-integration time-history, and can be used as
an option for modal time-history and response-spectrum load cases. Additionally, the
interactive database tables "Case - Response Spectrum 4 - Proportional Damping", "Case -
Modal History 4 - Proportional Damping", "Case - Direct History 3 - Viscous Proportional
Damping" and "Case - Direct History 6 - Modal Proportional Damping" have been enhanced
to include the ability to set the proportional damping type (Direct, Period, Frequency, Period
Ratio, or Frequency Ratio), the method used to specify the mass and stiffness coefficients.

API
Enhancements Implemented
* Ticket Description

6783 An enhancement has been made to the Application Programming Interface (API) to add
updated functions cPropFrame.GetChannel_2, SetChannel_2, GetDblAngle_2,
SetDblAngle_2, GetDblChannel_1, SetDblChannel_1, GetISection_1, SetISection_1,
GetTee_1, and SetTee_1 to include the fillet radius. Previous versions of these functions did
not include the fillet radius, but were otherwise identical. In the new functions, a fillet radius
of zero indicates no fillet radius.

Data Files
Enhancements Implemented
* Ticket Description

9323 An enhancement has been implemented where high-strength steel materials per the JGJ/T
483-2020 standard have been added to the Chinese material library. The steel frame design
per the Chinese 2018 code has also been updated to account for these materials.

9624 The Indian frame section library in XML format has been updated where numerous new
double-angle and double-channels sections have been added to the library. Additionally, 1)
The overall depth for one of the existing sections (ISMC250) has been corrected. The depth
was incorrectly listed as 350mm instead of 250mm in the XML library. 2) Missing section
properties have been added for some of the existing frame sections. Previously, the missing
properties for the affected sections were being calculated internally by the program when
importing the section.
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* Ticket Description
9743 An enhancement has been made to Function definition (response spectrum, time history,

steady-state, power-spectral density) to allow the specification of a Default Function Folder
that applies to all functions of type "From File". This is a global setting: It applies to the
current SAP2000 session, but it is not saved with the model; instead, it is saved for the user
when SAP2000 is closed. If the function data file is not found in the path specified in the
function definition, the software will recursively search the following locations in the order
given below, then load and use the first matching data file: (1) Folder where the
model file is saved, (2) Default Function Folder, (3) Program installation folder. The
corresponding API (Application Programming Interface) functions have been updated as
well.

Database Tables
Enhancements Implemented
* Ticket Description
* 9560 An enhancement was made to the tabular display to show detailed data for a single

database table row after double clicking on the row header on the left. Detailed data for
each row include the parameter (column/field) names, values, units, and descriptions for
each cell of the row and are presented in a separate table. This information can be exported
to Excel. In addition, the column header tool-tip on the database table display form now
displays full column description in multiple lines, with each line being no longer than 80
characters. Previously, only first 80 characters of the description were displayed.

Design – Cold Formed Frame
Enhancements Implemented
* Ticket Description

9593 An enhancement has been made to the Eurocode 3 1-3 2006 cold-formed frame design to
include 'distortional' in the heading for local buckling in the design report to clarify that the
distortional buckling effects are incorporated (or embedded) within the local buckling
calculations. This is only a reporting display change. Calculations and design results are not
affected.

Design – Concrete Frame
Enhancements Implemented
* Ticket Description

9749 An enhancement has been made to concrete frame design for the IS 456:2000 code to
include a check for the axial compression limit of 0.4fck according to IS 13920:2016 for the
column design under seismic loads. The warning/error message, when applicable, will be
displayed in the right-click design details form as well as in the design results table.

Design – Steel Frame
Enhancements Implemented
* Ticket Description
* 9423 An enhancement has been made to add steel frame design based on the AS 4100:2020 code.

Documentation
Enhancements Implemented
* Ticket Description

9336 An enhancement has been made to provide a more detailed description of Methods 1 and 2
for concrete-shell shear design according to Eurocode 2-2004. Changes have been made to
the manual and the descriptions in the Design Preferences form.
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Graphics
Enhancements Implemented
* Ticket Description

9196 The size of the joints drawn in the model window is now consistently based on the Minimum
Graphic Font Size specified using the command Options > Dimensions/Tolerances in both
DirectX and Classical Plus (GDI+) graphics mode. Previously this was being done for DirectX,
but for Classical Plus graphics it was based on the average of the Minimum and Maximum
Graphic font size, and could be too large compared to the text for certain models.

9622 The graphic font size used to draw text in the model window has been changed to be
consistent with the point measurement specified using command Options >
Dimensions/Tolerances. This tends to be smaller, but more consistent, than the previous
scaling. As a result, the default Maximum Graphic Font Size and Minimum Graphic Font Size
have been changed from 8 and 3, respectively, to 12 and 6. The new values correspond to
1/6 and 1/12 inches, or about 4 and 2 mm, respectively. These values are the defaults, but
they can be changed by the user.

Installation and Licensing
Enhancements Implemented
* Ticket Description
* 9356 The version number has been changed to v25.0.0 for a new major release.

Loading
Enhancements Implemented
* Ticket Description

2572 The TSC-2018 response-spectrum function has been enhanced to allow specification of the
R, D and I parameters. The new parameter values will be set to 1.0 when opening models
from versions prior to SAP2000 v25.0.0 to ensure that results are not changed. The values
can be updated in the response-spectrum function definition after opening older models in
the new version, if desired.

* 9436 Enhancement has been made to add auto-wind loads, auto-seismic loads, and response-
spectrum function based on NBCC 2020.

* 9543 Automated wind loads have been implemented for the ASCE 7-22 standard.
* 9544 The automated response-spectrum function has been implemented for the ASCE 7-22

standard.
* 9545 Automated seismic loads have been implemented for the ASCE 7-22 standard.
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Structural Model
Enhancements Implemented
* Ticket Description
* 9427 The frame hinge assignment feature has been enhanced with four new preset hinge

assignment distribution types: (1.) Beam Column, which adds a moment or PMM hinge at
the ends of the frame object. This is intended to be used for most typical beam and column
members which are governed by flexural behavior and expected to yield at one or both ends
of the member while maintaining elastic or nearly elastic behavior at the mid-span. (2.)
Distributed Plasticity, which adds hinges along the length of the frame object based on a
specified integration rule. This is intended to be used for frame objects that are expected to
have complex yielding behavior over the entire length. (3.) Equal Spacing, which adds hinges
at a fixed spacing along the length of the frame object. Similar to the Distributed Plasticity
option, this is intended to be used for frame objects with complex yielding behavior but may
be used where yielding is expected to be evenly distributed or concentrated at mid-span.
(4.) Continuous Support, which adds one hinge at the center of every frame element
associated with the selected frame object. This is intended to be used for piles or grade
beams, which are supported by springs at specified intervals and are meshed at the
intersection with these supports, to facilitate the placement of hinges between each
support. A User Defined hinge distribution type is also available to allow free-form
assignment of hinges, which corresponds to the previous method of hinge assignment.
When a model from a previous version of the program is opened, the hinge assignment is
automatically translated as a User Defined hinge distribution. A new Hinge Length Overwrite
parameter is available for hinge assignments using User Defined hinge distribution type. This
parameter overwrites the hinge length of the assigned hinge with either an absolute length
or a relative length as a ratio to the clear length of the frame object. The overwrite is
intended to facilitate the use of Fiber or strain/curvature-type hinge properties in multiple
locations or frame objects without having to redefine the hinge property to change the
hinge-length setting. The database table "Frame Hinge Assigns 00 - Hinge Distribution Type"
has been added to the interactive database. This table can be used to view or edit the hinge-
distribution types for the frame hinge assignments. Additionally, the database tables Frame
Hinge Assigns 02-08 and 10-21 have been updated to include the new Hinge Length
Overwrite parameters. A new API function cFrameObj.GetHingeAssigns_2 has been added
which includes parameters for hinge distribution type and hinge length overwrite.

9618 The Frame Hinge Overwrite (Assign > Frame > Hinge Overwrites) option for auto subdividing
line objects at hinges has been enhanced to add an additional parameter "Use Hinge Length
Overwrite Instead, if Available". This option is available when auto subdivide is enabled.
When this new option is selected, the line object will be subdivided around the hinges using
the hinge length overwrite value from the frame hinge assignment instead of the specified
auto subdivide length. This option has also been added to the database table "Frame Hinge
Assigns 09 - Hinge Overwrites" and is available for interactive database editing. Additionally,
the default relative length for auto subdivide has been changed to 0.2 (previously 0.02).

User Interface
Enhancements Implemented
* Ticket Description
* 7258 Model Explorer functionality has been added. This provides quick access to many of the

forms used to define and assign properties, review model geometry, and perform other
functions. This functionality can be accessed via the Model Explorer window, which presents
expandable/collapsible tree structures for viewing the model components and performing
tasks. This window is located by default on the left side of the screen, but it can be moved or
turned on and off. Two tabs, namely "Model" and "Display", are available. The "Model Tab"
provides quick access to many forms used to modify and review the model definition. The
"Display" tab can be used to display the model definition and results, as well as to customize
model views in the graphical user interface.
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* Ticket Description
9330 A change has been made to the language of the message that is presented when running a

plugin from the Tools menu. It is also now possible to set the message for each plugin to not
display during subsequent runs.
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Analysis
Incidents Resolved
* Ticket Description

9552 A change has been made to not to allow multi-stepped moving load and wave load pattern
assignments to linear and nonlinear static load cases or to stages of nonlinear staged-
construction load cases. Previously such assignments were permitted, but the load was not
applied or it used the first step of the load pattern, which was not consistent with the multi-
stepped nature of load pattern itself. In addition, multi-stepped wind load pattern
assignments are not allowed for time history load cases, since the multiple steps represent
spatial angles rather than a sequence of load steps. When run, such load cases will be
skipped and a corresponding message will be added to Analysis Messages.

API
Incidents Resolved
* Ticket Description

4180 An incident was resolved for the Application Programming Interface (API) where the
functions PropFrame.SDShape.SetReinfCircle, SetReinfCorner, SetReinfEdge, SetReinfLine,
SetReinfRectangular, and SetReinfSingle did not create the reinforcement bars properly. This
caused the bars not to be shown in the Section Designer interface or the database tables,
and also excluded them from the calculation of the moment-curvature relationship in
Section Designer.

9447 An incident was resolved for the Application Programming Interface (API) where the
function SetLoadPoint is used to set Dir to 7, 8, 9, or 11, corresponding to the projected
directions for uniform loads, is not applicable for point loads and will now return an error
code. Previously, they were available in both the function and documentation, and when
used would erroneously apply load in the global Z direction.

9576 An incident was resolved for the Application Programming Interface (API) where the
documentation for the method cPropFrame.SetTube_1 incorrectly labeled the radius
parameter as optional. This was a documentation error only, and the function worked
correctly when the radius parameter was supplied. In addition, a radius input less than the
tube thickness was previously not allowed. That restriction has been removed and the radius
can now be set to zero if it is not used.

9580 An incident was resolved for the Application Programming Interface (API) where the
function SapModel.NamedSet.GetJointRespSpec would incorrectly dimension the
DampingValues output argument, appending an extra null value to the end of the data
array. Additionally, minor typos that would create compile-time errors were fixed in the API
documentation for SapModel.NamedSet.GetJointRespSpec and
SapModel.NamedSet.SetJointRespSpec.

9729 An incident was resolved for the Application Programming Interface (API) where the
function cDatabaseTables.GetAvailableTables did not return the frame design results tables
for steel, concrete, aluminum, and cold-formed frame design. The tables themselves were
available, but they were not included in the list of available tables.

Data Files
Incidents Resolved
* Ticket Description

9538 An incident was resolved where some of the section properties for the sole double-channel
section in the AISC15 and AISC15M section libraries were incorrect. The double-channel
section has been updated to 2C15X50 and 2C380X74 in the AISC15 and AISC15M libraries,
respectively, with a back-to-back distance of zero. It should be noted that v15.0 of the AISC
Shapes Database does not provide any double-channel sections. A single double-channel
section, however, has been given in the included AISC15 and AISC15M libraries as a
template for users to add more double-channel sections, if desired.
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* Ticket Description
9539 An incident has been resolved to update the strain value at compressive strength for the

concrete materials in the Canadian material library. Previously, the strain values were too
low compared to the elastic strain at the compressive strength. This caused an unrealistic
nonlinear stress-strain relationship of the concrete materials based on Mander's model, and
consequently resulted in an error computing moment-curvature relationships. The updated
strain values are now based on Hognestad's model (see Hognestad, 1951 - A Study of
Combined Bending and Axial Load in reinforced Concrete Members).

9755 An incident was resolved where a function data file with an ASCII end-of-file character (^Z)
at the end failed to load when adding a new function of type “From File”. In particular, this
affected the Elcentro record that was included with the software.

Database Tables
Incidents Resolved
* Ticket Description

9355 An incident was resolved where the interactive database could display an error message
when the changes were applied if the model included cold formed or aluminum frame
sections and an analysis had been run prior to performing the interactive database import.
When this occurred, the changes were correctly applied, but the interactive database editor
was no longer usable until the software was closed and restarted. The model was not
affected.

* 9361 An incident was resolved where the following database tables failed to import on machines
with Windows regional settings format set to Turkish. This could affect the import of
database files and the use of the interactive database editor even if these specific tables
were not included among those being imported: "Function - Response Spectrum - JTGTB02-
2013", "Function - Response Spectrum - JTGT2231-01-2020", "Function - Response Spectrum
- NZS 1170.5-2016", "Frame Section Properties 17 - PCC Super-T", "Rail Track Support
Property Data", "Rail Track Temperature Load Data", "Frame Rating Resistance - Axial
Service", "Frame Rating Resistance - Axial Ultimate", "Bridge Section Definitions 29 - PCC
Super-T 1 - General", "Bridge Section Definitions 30 - PCC Super-T 2 - Spacing", "Bridge
Section Definitions 31 - PCC Super-T 3 - Sections", "Bridge Section Load Definitions 01 -
Haunch", "Bridge Section Load Definitions 02 - Stay In Place Form", "Bridge Section Load
Definitions 03 - ConcPour Permanent", "Bridge Section Load Definitions 04 - ConcPour
Temporary", "Bridge Section Load Definitions 05 - Barrier", "Bridge Section Load Definitions
06 - Sidewalk", "Bridge Section Load Definitions 07 - Wearing Surface", "Bridge Section Load
Definitions 08 - Temperature Change", "Named Sets - Run Bridge Design", "Named Sets -
Run Bridge Column Design", "Named Sets - Run Bridge Rating", "Named Sets - Run Bridge
Seismic Design", "Named Sets - Run Member Rating", "Named Sets - Bridge Seismic Design
Report".

9403 An incident was resolved where the first column of the "Constraint Definitions - Diaphragm"
table could be blank when shown in Excel. Also, text fields exported to Excel have been
changed to be formatted as Text instead of General.

9669 An incident was resolved where the 'Function - Response Spectrum - From File' table was
showing the Frequency field incorrectly. It was displaying the period value (1 / frequency)
instead of the frequency. This was a table display error only with no affect on analysis
results.

9765 An incident was resolved where some analysis output tables may not populate correctly if
they are shown from the Advanced Report Writer after opening a Saved Named Set.

Design – Aluminum Frame
Incidents Resolved
* Ticket Description
* 9475 An incident was resolved for the EN 1999:2007 aluminum frame design code where the

unbraced length for lateral-torsional buckling was determined incorrectly when it was
defined using the command Design > Lateral Bracing with type of brace being either top or
bottom and there were multiple load combinations to be designed.



SAP2000 v25.0.0 ISO #RELSAP2500     07-Jul-2023 Page 8 of 11

Design – Cold Formed Frame
Incidents Resolved
* Ticket Description
* 9472 An incident was resolved for the Eurocode 3 1-3 2006 cold-formed steel frame design code

that addressed two issues: (1.) The unbraced length for lateral-torsional buckling was
determined incorrectly when it was defined using the command Design > Lateral Bracing
with type of brace being either top or bottom and there were also multiple load
combinations to be designed. (2.) The location of the station is now reported correctly in the
design report for any design section that is in tension. Previously it was always shown as
zero. This was only an issue with the display in the design report.

Design – Concrete Frame
Incidents Resolved
* Ticket Description

9153 An incident was resolved for concrete frame design where the unbraced-length ratio
displayed using the command Design > Concrete Frame > Display Design Info > Design Input
> Unbraced Length L-Factor could be incorrect, instead showing the length of the member,
or zero. This was a display issue only and did not affect the design results.

9368 An incident has been resolved for concrete frame design codes “ACI 318-11”, “ACI 318-14”,
“ACI 318-19”, "KBC 2009", and "KBC 2016" where the reported value of Pu for the
“SHEAR/TORSION DESIGN for V2 and T” in the detailed design report “Concrete Design
Data” was not correct. It was always reported as zero. This was a display issue only, and all
other design results were not affected.

9395 An incident has been resolved for the crack width design of the Eurocode 2-2004 and Italian
NTC 2008 frame design codes which addressed the following issues: (1.) The neutral axis
angle of the column (not beam) section subjected to either M3 or M2 moments (not both) is
now correctly determined with higher accuracy. Previously, this angle might have been
slightly off from the expected value due to iteration and assigned tolerance. (2.) The clear
cover for the most extreme reinforcement for section designer sections is now properly
determined. Previously, it was taken as the distance from the center of the bar to the most
extreme concrete fiber in tension. Now, it is determined as the distance from the center of
the bar to the intersection of the edge of the section that is closest to the bar and the line
that is perpendicular to the direction of bending and that goes through the center of the
bar. (3.) The required amount of reinforcement for beam (M3) design is increased by
constant increments until the crack width, concrete and steel stresses satisfy the
requirements. Previously, the incremental amount of reinforcement was relatively large and
in several cases resulted in the reinforcement amount exceeding the maximum allowed. (4.)
Error and/or warning message are now shown in the design details.

9449 An incident was resolved for Mexican RCDF 2017 concrete frame design code where shear
capacity of a frame was using fc* instead of f'c. This always yielded a conservative design.

9615 An incident was resolved for Eurocode 2-2004 and Italian NTC 2008 concrete frame design
where the transverse torsional reinforcement area was enveloped incorrectly. The issue
occurred when multiple load combinations and/or a load combination with seismic loads
were selected for design.

9767 An incident was resolved where the software could terminate abnormally when attempting
to remove an automatically generated load combination from the Concrete Frame design
"Design Load Combinations" list in the Design Load Combinations Selection form.
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Design – Concrete Shell
Incidents Resolved
* Ticket Description

9662 An incident has been resolved for the Eurocode 2-2004 concrete shell design in which the
cracked condition was not displayed correctly for multistep load cases/combos with
"Cracked" being selected for the crack condition in the Concrete Shell Design Preferences.
This was only an issue when displaying the cracked condition in the concrete shell design
result table. The actual design results were not affected.

Design – Steel Frame
Incidents Resolved
* Ticket Description
* 9400 An incident was resolved for the AISC 360-16 steel frame design code where the HSS

moment capacity was computed incorrectly when the section was slender. The previous
calculations were unconservative.

9602 An incident was resolved for the AS 4100-1998 and NZS 3404-1997 steel frame design codes
where frame steel overwrites were lost when model was imported from a text file.

9664 An incident has been resolved for all steel frame designs except AISC-ASD89, AISC-LRFD93,
API RP2A-WSD2000, and API RP2A-WSD2014 in which the compactness of pipe sections was
determined incorrectly. This only affected user-defined pipe sections where the wall
thickness was modified by the user. Pipe sections imported from section libraries were not
affected.

9720 An incident was resolved for the Chinese steel frame design code “Chinese 2018” where the
value of Gamma_RE(S) was not reported correctly in the “Steel Stress Check Data Chinese
2018” form. This was a reporting error only. The actual values that were used for design
were correct.

9774 An incident was resolved for the Italian NTC 2008 and NTC 2018 steel frame design in which
the modification factor, f, that increases the value of the lateral-torsional buckling factor,
Chi_LT, was conservatively being taken as unity. Now, it is calculated according to Equation
4.2.52 in the Italian NTC 2018 steel design code.

Documentation
Incidents Resolved
* Ticket Description

7093 A documentation error was corrected for auto seismic load according to ASCE 7-05, ASCE 7-
10, ASCE 7-16, IBC 2006, IBC 2009, and IBC 2012 codes to clarify that the importance factor
(I) is a user input. Previously, it was stated that the importance factor was determined from
the occupancy categories. This was a documentation change only.

Drafting and Editing
Incidents Resolved
* Ticket Description

7590 An incident was resolved where the coordinates of joints drawn in DirectX graphics mode
could be inaccurate, especially for models with meter database length units. Note that the
database units are those in effect when the model is first created or imported, not
necessarily those selected at the time of drawing.

8399 An incident was resolved where the drawing of rectangular area objects in the YZ plane was
not using the correct mouse-click locations in DirectX mode. Classical Plus graphics mode
was not affected.

9304 An incident was resolved where selection by coordinate range might not work correctly for
user defined coordinate systems whose origin is offset from the Global origin.
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External Import and Export
Incidents Resolved
* Ticket Description

9365 An incident was resolved where solid objects were not being imported from DXF files,
regardless of whether they were drawn as AutoCAD extruded solid objects or as AutoCAD
3D polylines. This incident affected SAP2000 v24.1.0 and v24.2.0, and when it occurred, the
error was visually obvious. Results agreed with the model.

* 9387 An incident was resolved where wrong (or illegal) load patterns were assigned to load cases
exported to SAFE when the order of load patterns as they were defined in the model was
different than the order of load patterns as they were exported to SAFE. Results agreed with
the model as imported into SAFE. Creating a dummy linear static load case, applying all load
patterns in the order they were defined, moving it to the first place in the list of load cases,
and exporting it to SAFE along with the rest of the desired load cases prevented the issue.

Graphics
Incidents Resolved
* Ticket Description

5356 An enhancement was made for DirectX graphics mode so that when the Set 3D View
command specifies an elevation angle of +90 or -90 degrees, the view direction is now
directly along the +Z or -Z axes. Previously the view deviated from these directions by a
small angle tolerance. Note that text rendered when looking from above (+Z) may not be
shown from below (-Z), and this is intentional.

8232 An incident was resolved where null (None) areas were not filled in DirectX graphics mode
when the fill color was to set to be based on section or material properties. Now a Gray
color is used for filling null areas, the same as for Classical Plus graphics, when displaying
colors based on section or material properties.

8287 An incident was resolved where the "rubber-band" selection box that appears when using
the mouse to perform a window-select operation could appear distorted in DirectX graphics
mode when the view was zoomed in. This effect was more pronounced when working in
meter length units than inch or mm units. Note that very high zoom levels, some distortion
may still appear due to the level of precision available in DirectX graphics cards. However,
the effect has been much reduced.

8335 An incident was resolved where the font size for displaying tendons loads was not
reasonably consistent with other text in DirectX graphics mode.

8433 An incident was resolved where one Joint NL Link was not shown selected in DX mode.
8522 An incident was resolved where the display did not always show the correct orientation in

DirectX graphics mode when the elevation angle was set to +90 or -90 degrees, in other
words from directly above or directly below the structure. This was particularly evident
when the aperture angle was set to zero using the View > Set 3D View command. This was a
display issue only.

9141 An incident was resolved where the edge-fill color of extruded area objects was incorrect
when the view display options were set to color objects by section or material. This was a
graphical display issue only.

Loading
Incidents Resolved
* Ticket Description

7663 An incident was resolved where a linear load case added to a model using the Application
Programming Interface (API) with applied seismic load pattern(s) failed to update program
calculated seismic loads using the seismic mass corresponding to the specified mass source.
Analysis results were affected only if the load case was run within the same session that it
was added. Saving and re-opening the model permanently fixed the issue.
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* Ticket Description
* 9170 An incident was resolved where seismic or wind loads that depend on mass were not always

updated to use the current mass when applied in a staged-construction load case. Running a
linear case with aforementioned seismic or wind loads before running staged construction
cases prevented the issue from occurring.

* 9422 An incident was resolved where the rotational-velocity accelerations were sometimes
incorrect for the seastate type of load pattern. These types of loads generate centripetal
forces for rotation about an axis. The accelerations were correct for rotations about
individual global axes, but were incorrect about any other axis. Only rotational-velocity
terms were affected. Translational and rotational accelerations were not affected.

9764 An incident was resolved for the Eurocode 8-2004 response spectrum function for Singapore
where the default function for Ground Type C was creating invalid function data (non-
monotonic period values) that caused an error during analysis. Results were not available for
load cases using this function.

Results Display and Output
Incidents Resolved
* Ticket Description

9687 An incident was resolved where, when viewing fiber hinge fiber results (Display menu >
Show Hinge Results) for a concrete fiber using a Mander-type concrete material model, the
backbone curve was not always displayed correctly. This was an issue with the displayed
backbone curve only and did not affect the reported results.

Structural Model
Incidents Resolved
* Ticket Description

9657 An incident has been resolved for the concrete stress-strain relationship based on Mander's
model in which the modulus of concrete is smaller than the ratio of concrete strength over
the strain at this strength. In such situation, the Mander's model shows peculiar behavior in
the nonlinear stress-strain curve in the material properties form. Now, the modulus of
concrete will be set to have a lower limit of 1.2 times the ratio of concrete strength over the
strain at this strength if it is less than this value [see Technical Note - Material Stress-Strain
Curves (S-TN-MAT-001.)] Additionally, the value of Ec used in Mander's model is now taken
from the concrete material properties. Previously, it was always taken as 57,000*sqrt(f'c)
[psi] in calculation of the moment-curvature relationship in section designer and plastic
hinge properties.

User Interface
Incidents Resolved
* Ticket Description

9257 An incident was resolved on the Select by Labels form where the Increment input field was
disabled when the option to specify by increment was selected and the model was locked.
This was a minor user interface issue only.

9645 An incident was resolved where the "Force Deformation Data" form for Parametric Steel and
Concrete P-M2-M3 hinges (Define menu > Section Properties > Frame/Wall Nonlinear
Hinges) disabled the "Show Scaled Data" checkbox when the model was locked, preventing
the force-deformation plot display from being displayed using the scale factors in a locked
model. This was a display issue in this form only and did not affect analysis or results output.


